Bl Fiori Launch Pad Overview T

You can perform a fresh SAP Bl 4.3 full install or upgrade your previous SAP Bl 4.x
system. In both cases, you need a new 4.3 license that can be downloaded from
the SAP Support web site.

Once installed and deployed, you can connect to the Bl Launch Pad through its Login
page, whose URL is by default http://<server>:<port>/BOE/BI

Log in to Bl Launch Pad

boe:6400

cas

==

Contact Administrator

Bl Launch Pad: Login Page

After you have authenticated, the Home page presents some tiles that give you access
to repository’s resources:

- Folders: to navigate in the Bl Platform repository folders.


https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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Categories: to navigate in the Bl Platform repository categories.

Documents: to display your documents as a flat list.

Bl Inbox: to access the documents and alerts you have received.

Instances: to give you an overview of all your schedules and publications.

Recycle Bin: to display and restore documents you have deleted.



Documents Bl Inbox Instances Recycle Bin
l = |

ZZ_Charting ZZ_Multiple Data
Jun 13, 2020 4:31 AM Sources
Jun 13, 2020 4:31 AM

ZZ_Time Dimensions ~ ZZ_Rio Games 2016 ﬂ ZZ_Multiple Data
Jun 13,2020 4:31 AM Jun 13,2020 4:31 AM

ZZ_Charting
Sources Jun 13,2020 4:31 AM
Jun 13,2020 431 AM

Bl Launch Pad: Home Page

Under these tiles, three sections with document tiles are displayed. These documents
are the ones:

- You have set as favorites (Favorites)

« You have previously opened (Recent Documents)



- That have been recently processed through schedules (Recently Run).

Finally, the Applications section contains tiles you can click to start the corresponding
application hosted in Bl Launch Pad. These applications include Web Intelligence.

Applications
SAP Analytics Web Intelligence Crystal Reports for Analysis edition for Bl Workspace Information Steward
Cloud Enterprise OLAP

e 1] ]
)
wse

Bl Launch Pad: Applications Tiles

To modify the Bl Launch Pad settings, click the icon (8) at the top left of
the Home page, then Settings to open the Settings dialog box.

- In the Application Preferences section, click the Web Intelligence tab to
display the Web Intelligence preferences. In addition to the usual drill, Excel save
or right-to-left orientation options, you can also define your measurement unit
(centimeters or inches). This was previously defined at document level and you
had to set it for every document.



Settings Application Preferences

GENERAL WEB INTELLIGENCE ~ CRYSTALREPORTS  ANALYSIS EDITION FOR OLAP

User Account

Administrator

When viewing a document:
gu} Account Preferences

Edit Acc it Prefi
ft ficcount Freterences Use the document locale to format the data

@ Application Preferences

Edit Application Preferences

*) Use my preferred viewing locale to format the data
(%) Appearance Measurement unit:

Fiori 2.0
Centimeters

* Inches
Drill options:

Synchronize drill on report blocks

Select a priority for saving to MS Excel:

Prioritize the formatting of documents

®) Prioritize easi data irocessini in Excel

Bl Launch Pad: Web Intelligence Preferences

- In the Appearance section, you can also choose another Fiori theme for the
user interface, for example a high contrast display for Bl Launch Pad and Web
Intelligence.



Appearance

Fiori Theme SAP Belize High Contrast Black

| Appty Changes

Web Intelligence: High Contrast Display

To open a Web Intelligence document:

- Ifitis displayed on the Home page as a tile, click this tile to open it
in Reading mode

- If you access the document through the Folders, Categories or Documents tile,
click the More button (ec0) to open the contextual menu. This menu contains the
different actions you can perform on this document, including View to open it
in Reading mode or Modify to open it in Edit mode



Folders Selected Folder

> [ My Folders Public Folders / Web Intelligence Samples / C +
5] My Subscribed Alerts Web Intelligence Samples
v [5] Public Folders E Description:
Last Updated: Jun 13, 2020 2:00 AM

> [ Auditing

Title . Favorites =~ Type Description Last Updated
> [5] Data Federation

**] Resources Foider Jun 13, 2020 2:00 AM
> & 1™

w ZZ_Activity Follow-up Dashboard Web Intelligence Jun 13, 2020+ \rey
> = Platform Search Scheduling w ZZ_Charting Web Intelligence Jun 13,2020+ properties
> [ Probes w ZZ_Fold Unfold Web Intelligence Jun 13, 2020+ Modity

w ZZ_Input Controts Web Intelligence Web Intelligence 4.0 sampl...  Jun 13,2020 Schedule
> [ Report Samples > "

w ZZ_Multiple Data Sources Web Intelligence Jun 13,2020 Mobile Properties
> [ Scheduling doc » ZZ_Rio Games 2016 Web Intelligence Jun 13,2020 History

ZZ_Sales Analysis Dashboard Web Intelligence Jun 13, 2020, Categories

> [5] System Configuration Wizard lises 5 ge egor

s ZZ_Time Dimensions Web Intelligence Jun 13, 2020+ Mark As Favorite
> [F] Visual Difference Details
> 5 Web Intelligence Samples Organize

Send To
> = Workflow Assistant
Delete

Bl Launch Pad: Document Menu

For more details about Bl Launch Pad's new features, see SAP BusinessObjects Bl 4.3:

What's New.

Web Intelligence: Reading Mode T

The Web Intelligence Reading mode proposes a simplified interface in which users can
easily view, refresh and export documents. It proposes some interactivity and analysis
capabilities through input controls, elements linking, drill or track changes. In SAP Bl
4.3, this Reading mode interface is similar to the Web Intelligence Interactive Viewer
FIORI-based interface released since SAP Bl 4.2 SP4.

Main Toolbar
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The toolbar contains sections with the following commands:

File

- @&k Opens the menu with the Save and Save As

. b: Undoes the last actions.

d: Redoes the last undone actions.

. %]: Opens the Print dialog box to set parameters (report and page selection,
page size, orientation, margins and scaling) and generate a PDF that can be
printed out.

. m: Opens the Export to dialog box to export the report’s or cube’s data into
different file formats. The dialog box has been reorganized to better display all
possible options (Request 215268) and to propose the Excel format by default
(Request 140228).


https://influence.sap.com/sap/ino/#/idea/215268
https://influence.sap.com/sap/ino/#/idea/140228

Csv

Reports Options

Export to
(83 Excel * Reports Data
E_ PDF Search Q,
&> HTML Al
T | Summary(Current Report)
= EE sV Geo Map
Tables
Sections
References
RAW DATA

Web Intelligence: Export to Dialog Box

. X Opens the Send to users dialog box in which you can select the users or
groups that are to receive this document in their Bl Platform repository inbox.



. @: Opens the Online Help on the SAP web site.

. m: Displays the Web Intelligence version.

Data

. C Refreshes the document’s queries that have been selected for refresh by the
document’s designer. In the new interface, this button is more visible
(Request 131476), especially when a data provider has been partially refreshed.
In this case, a warning is sent and an orange dot (C.) is added to
the Refresh button (Request 206429).

/1\ Partial content loaded in Query 1 x

Web Intelligence Refresh: Partial Refresh Warning

Analyze
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Y Opens or closes the Filter Bar used to dis%Py and set filters values (see
description below). Another icon is displayed (= ®) if (a) filter(s) already
applies/apply to the current report.

Drill checkbox: Enables/disables the drill mode.

Fold/Unfold checkbox: Enables/disables the fold / unfold.

Show Changes checkbox: If the “Track Data Changes” feature has been
enabled, use this checkbox to highlight these changes.

2. Opens the Track Data Changes dialog box in which you can enable/disable
the tracked changes, define the dataset reference and the reports to compare. It
also displays the fonts and colors used to show the differences.

C‘: Switches to the "Auto Refresh" mode in which the document is refreshed
regularly and automatically (see SAP Bl 4.2 SP6). Before entering this mode, you
need to define a refresh frequency and answer potential prompts if any. These
values are kept for the next refresh actions, as long as you remain in this mode.
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File Data Analyze

@ 5 ¢ . ¢ %8

Summary Geomaps KPI Charts I Bl W

| | Fold / Unfold

Margin vs Target (Format SHoW Cranges

2 Track Data Changes... P

2500000 - (”, Auto Refresh

Reading Mode: Auto-Refresh

Filter Bar

In Reading mode, the Filter Bar is the single place where you can see and, when
possible, modify the filters and input controls that impact your document’s dataset.

gy © ¢ . ¢ K8 -

Prompts Year Lines Category | Quantity sold
@ 1 Prompts & 2018 (1 more) [El Dresses All Values 350,000 Ve

Report 1
@ Product Line Analysis  ———)
0 1000000
350000
Reset OK

Reading Mode: Filter Bar



In detail, the Filter Bar contains the following items:

- The Reset button (@) to reset all input controls to their default values and
remove the element linking filtering (Request 144999).

- The prompts that have been answered during the document’s queries execution.
Click Prompts (@':) to see these values. To modify them, refresh your document
and provide new values for the prompts.

- The document’s input controls (@J) that apply to the whole document, and the
report input controls (FE1]) that apply only to the current report. Click an input
control to modify its values using list, multi-list (checkboxes), slider, spinner...
depending on the document’s designer choice. For list and multi-list, a search
text field can be used to find only the values that match a search string.For a
group of input controls, click the group and select the input controls to add. The
order in which you select the input controls defines the filter path, i.e. the input
controls' dependencies. For example, if you select Country before City, the
selected countries filter your choice of cities.
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- Element linking through which %block is filtered by a value selected in a table.

Click the element linking icon (") to display the value of this element linking and

reset it, if needed.

If the window is too small to display the full Filter Bar's content, then arrows are
displayed on its edges allowing you to scroll.

Year Lines Categ
/ e 2018 (1 more) ® I'A‘E] = Dresses 4 -

Reading Mode: Filter Bar Scrolling Arrows

Report Selection and Vanishing Toolbar

In Reading mode, you can move from one report to another by clicking the
corresponding tabs displayed under the toolbars.

To navigate in the report, you may use the Vanishing Toolbar at the bottom of the
page. This toolbar appears when you move your cursor to the bottom of the page and

>

disappears when you stay idle for a few seconds. This toolbar contains the following

commands:

- The controls to go to the first page, previous page, a specific page, next page or

last page.



. X®]; Opens the Zoom slider to select the zoom ratio.

= Toggles between the Print layout and the Draft

£ Fits the page’s width to the window’s width.

Z: Fits the page to the window.

GoTo K 4 ' | of350+ > ) @ &

Reading Mode: Vanishing Toolbar

Side Panel

130%
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Unlike the previous releases, the side panel is located on the right. To open or close this
side panel, click one of the buttons in the toolbar depending on the content you want to
display:

—: The Navigation Map pane, to quickly navigate in the report based on its
sections.

2

. &J: The Comments pane, containing the comment threads. Click an existing
comment in the document to view its thread or right click a report element in the
document to comment it.

. EI: The Document properties pane, to display the document's statistics and
properties (Refresh on open, document style, ...)

16



= [ENCIRETS = < [FIRED = @ [ o

EE Na\rigation Map m Sesiment properties

Results Add a comment > General
Search for... Q »  Statistics
Archery > Administrator: ® ‘
May 28, 2020, 1:15 AM > Document Options
Artistic Gymnastics >
Aggregated total {\s! Data Options

Athletics > geree Lo P

Refresh on open:
Badminton > No
Basketball ’ Apply security filtering on open:
Beach Volleyball > No
Boxing 5 Use query drill:

No
Canoe Slalom >
Canoe Sprint >
Cycling BMX >
Cycling Mountain Bike >
Cycling Road >
Cycling Track >
Diving >

Eq UEStrian >
rin

Reading Mode: Navigation Map, Comments and Properties Side Panels

Web Intelligence: Edit Mode T

The main improvement in SAP Web Intelligence 4.3 is the Edit mode. It completes the
FIORI convergence (Request 209030). This mode has been simplified to improve the
productivity of report designers by allowing them to perform tasks faster.
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There are several ways to open the Edit mode:

- By clicking the Web Intelligence tile on the Bl Launch Pad Home page and
creating a new document.

- By selecting the Modify command (ec) on the document menu allowing you to
edit this document.

- In Reading mode, by clicking the Edit button to edit the current document.

Main Toolbar

The toolbar contains only general commands that apply to the overall document. These
commands should be familiar and have been reorganized for a simpler and faster
access (Request 107473).

File Data Insert Analyze Display
@v 5 ¢ .. B cv[B 8 v = = BR . & =
Prompts ¢ Change Source...
® 2 F.,Drfpts =] YJ:EK LY ® %, Report Structure

Purge Data...
Summary ~ Activity Follow-up ~  Explorauwsrrwinrvasvaun——Exploration with element ... ~ References + [=] Activity Follow-up I

# [2F » | =ReportName() ™ Header


https://influence.sap.com/sap/ino/#/idea/107473

Edit Mode: Toolbar
The toolbar contains sections with the following commands:
File, that contains the same commands as in Reading mode

Data

. ﬁ"{f}: Opens the Query Panel allowing you to edit the document’s queries.

. C Opens the Refresh menu described below. As in Reading mode, when a
data provider has been partially refreshed, an orange dot is displayed on
the Refresh button (CG) to provide you with a visual "document contains partial
data".

- Change Source: Opens the Change Source Wizard dialog box, to change
universes, SAP BW or SAP HANA data providers.

- Purge Data: Opens the Purge Data Providers dialog box, to remove datasets
from queries.
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Insert

. @ Opens the menu in which you can select tables types and forms to insert into
your report.

. B Opens the menu in which you can select one of the default charts types to
insert. For further charts types, open the Turn Into section in the Data side
panel.

. [abe; Opens the menu in which you can select predefined cells to insert.

: Adds a section.

5 Inserts a custom element, if you have registered one in the CMC.

Analyze

20



- Y Opens/closes the Filter Bar (see below). As in Reading mode, an icon is
used to highlight that the dataset is filtered (v.).

. Ix Opens/closes the Formula Bar (see below).

- Drill, Fold/Unfold, Show Changes checkboxes: As in Reading mode, click
these checkboxes to enable/disable drill, enable/disable fold/unfold or show
document changes.

. @ Opens the Track Data Changes dialog box.

. I1: Opens the Manage Formatting Rules dialog box.

Display

TS Opens the Zoom slider to select the zoom ratio.
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. E?: Toggles between the Print layout and the Draft

- Structure checkbox: Use this checkbox to switch between Structure and Data

. £ Fits the page’s width to the window’s width.

Z: Fits the page to the window.

Navigate contains the same controls as in the Vanishing Toolbar of the Reading mode
to navigate in the report’s pages.

Depending on your screen size, some commands are reachable by opening
the More menu (coo).

Filter Bar

Like in Reading mode, you can use the Filter Bar to view and change filters values.
In Edit mode, you can in addition manage input controls and group of input controls,

through the Manage Input Controls button ().
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File Data Insert Analyze
&5 b d ooo0 % C N 000 @ N I=— i @ v :% ooo0 ﬂ

e 8 M. e lmere
-+ New Input Control C v ElementLinking v IC properties -+ Variable IC-1 -~ Variable IC
New Group of Controls > Overcoats 121,076
Manage Filter Bar... City Skirts 103,458

Outerwear 102,147

Reset All
Jackets 83,056

Edit Mode: Filter Bar

Click this button to open a menu with the following commands:

+  New Input Control: Opens the New Control dialog, in which you can provide

the different parameters to create an input control (the impacted object, its scope

document or report, the interface item used to modify it...)
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New Control *
Object ‘ Lines v I
Name | Lines
Description Enter control description
Current target Type  Multi-List v
ExEniEa Operator  In List v
e) Current report
User restricted list of values -+ Select values
v v Cascading IC
Sort list of values ~ None v
Header
Allow selection of all values m
v Body
= Block 1 Allow selection of null values | () OFF
s Block 3 Reset on refresh () OFF
Footer Default value(s) v
OK" Cancel

Edit Mode: New Control

- New Group of Controls: Once you have selected the scope of the group to
create (the whole document or the current report), the New Group dialog box
opens. You can give the new group a name and click Add Control to select the
input controls to add in this new group. If needed, you can click New Control to
create an input control on the fly and add it.
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New Group (Report) *

Name | Group 1

El Input Controls

/1N Select at least 2 controls

v] Lines
[¥i category
SKU number
== New Control

Edit Mode: New Group of Input Controls

- Manage Filter Bar: Opens the Manage Filter Bar dialog box listing all input
controls and groups. Select a group or input control and click the Edit icon (>) to



edit it or the Delete icon (®) to delete it.

To define the position of a group of input control on the Filter Bar, select it and
use the arrow buttons (iiand!!) to move it up and down in the list.

You can also create a group or an input control from this dialog box by clicking +
Add.

- Reset All: Resets all input controls to their default values and removes the
element linking filtering.

Another way to edit an input control’s properties is to click first the input control in
the Filter Bar, then the Settings icon (@) and finally Advanced Settings. This opens
the Edit Control dialog box.

Formula Bar

In the Formula Bar, you can enter a value or a formula in a cell. This Formula

Editor supports auto-completion: while you type a formula, a menu proposes the
objects, functions or operators that match the letters you have typed

(Requests 236699 and 241647). You may select the one to use by clicking it or by using
the arrow keys and pressing [Enter].

File Data Insert Analyze Display Navigate
By & 2 w B Cv w @By BEv BEv B .. | Y v & B . 1 ot
Summary ~ Cascading IC ~ Element Linking ~ IC properties ~ Variable IC-1 ~ Variable IG-2 ~ RAW DATA - +
£ G X | -NameOf(Lines) +Lin ]
LineNumber =
) Hals,gloves,scarves Accessories  Belts,bags wallets 177,860
v Linear Jewelry
Los Angeles @ ) Accessories  Belts bags wallets 178,435
:%: Lines Dalas = Lounge wear
3] b Samples Accessories  Hair accessories 148,032 g
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Edit Mode: Formula Bar

The Formula Bar contains the following four buttons:

- Display the Formula Editor: Opens the Formula Editor that can help you to
type the formula.

- Create a new variable using this formula: Opens the Formula Editor allowing
you to create a variable from the formula in the Formula Bar.

- Restore the initial formula: To cancel the formula you have entered and restore
the previous one.

- Validate the formula: To validate and save the current formula in the cell.

Report Tab

In the document, you access a report by clicking the corresponding tab below the Main
Toolbar and Filter Bar.
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Click the drop-down menu (~~) beside the report name to open the menu containing
commands to add a new report, duplicate, delete, rename or move the selected report.

File Data Insert Analyze

2 b d coo gf!‘ C 4 ooo @ N |=— e [aBe v/ £ coe V. fX eoo

Summary ~ Geomaps ~ KPI Charts Format Series ~ Bar Width ~ Waterfall ~ Axis Flat Layout

Duplicate

Quantity € i Delete
2,500

Rename
Move > First
2,000 Copy Link of the Report Previous
Next
1,500 | Last
]

Edit Mode: Report Menu
The last command in the menu (Copy Link of the Report) copies the Opendoc URL to

this report into the clipboard. You may copy and share this URL that can be used to
directly open this report.

Main Side Panel

The Edit mode proposes two side panels and as in Reading mode, they are located on
the right. By default, only the main side panel opens. It contains two stacked panels:
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- Report Structure: This panel displays the report structure with the different
blocks it contains.

- My Objects: This panel displays the document dictionary with all objects
retrieved by the queries and also the enrichments added by the document
designer.

Like in Reading mode, the buttons on the toolbar can be used to display the Navigation
Map, Comments and Document properties panels in the main side panel. In Edit
mode, they replace the Report Structure and My Objects panels when

selected. Document properties panel allows you to modify document’s options and
properties in Edit mode.
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a =% 0 Bl 2 = o E B3

. Report Structure ~ [i] Document properties

[£ Tables o0 > General
v [ Header
> Document Options
[« Block 2
_ Cell1 v Data Options
abe
" [ZZ_SAPLogo] R
#8 Table3 Refresh on open (O NO |
(5 Commentl Apply security filte... () NO
i Table2
Use query dril ;
@& My Objects v Allow query stripping
Q T v <+ Add Variable Merge prompts (B...
> 3& Sales Details V4 Auto-merge dimen... 'O NO )
> (& City Details Extend merged di... O NO |
> (& State Area 4

> Default Style
> Merged Dimensions

» Variables

> References
Apply. Print

Edit Mode: Main Side Panel

Main Side Panel: Report Structure

As in previous releases, the Report Structure displays a tree of all items in the current
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report: header, footer, charts, cells, tables, ...

%. Report Structure ~

=] Sales Analysis l
> [ Header
[t Cell 3
[ Cell 3

(= Gauge QS !

Geo Pie QS n

= Paref V' Edit Filter

"
Ls

"L

= Wate &> Format
~ Line 2¢ Data
(» Gauy T Delete

& Doni

Hide
B Cell

] Bring Forward
(s Cell W’ Bring to Front
(» Gauy W send Backward

> [ Foott & send to Back

Edit Mode: Report Structure Side Panel

It can be useful to understand how a report is organized and access a specific block
rather than looking for it in the document: if you click the More icon (eee) beside an item,
the Format and Data commands open the Format and Data panels described below.

Main Side Panel: My Objects
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The My Objects panel lists the document’s dictionary. In this panel, you manage the
objects retrieved from the document’s queries, the enrichment you defined for these
objects as well as the variables and references you create. For example, to add a new
variable, click Add Variable, to opens the Formula Editor and create your variable.

@ My Objects v

T v + Add Variable

 [Search

v Dimensions

> &2 City
<% Latitude
< Longitude

> < Month

> &b State ()
< StateArea
< Store name
< Year

v Measures

o Area

™2 Inhabitants

Edit Mode: My Objects Panel

You can display these objects in alphabetical order, by folders or by queries. The
corresponding options are Alphabetical View, Folders View or Queries View and are
available in the View Mode menu (TJ,)_



Click the More options icon (ec<) beside an object to open its contextual menu with the
usual actions you can perform:

- Enriching a dimension by making it a geo or time dimension

- Merging / unmerging objects

- Managing groups

- Editing object properties

- Setting the measure type to Number or Decimal

- Defining a custom sort for the object

33



. -
& My Objects '

Q Ty ~ + Add Variable

v~ Dimensions

> @ City u

2 Unmerge...

/ Edit Properties...

@ Edit as Geography by: Name

& Edit as Geography by: Latitude / Longjtude...
Reset Geography

[=] Manage Groups...

4= Custom Order...

v Measures

== Area

Edit Mode: My Objects Contextual Menu

This panel works in a similar way than in previous releases. There are, however, a few
usability enhancements:

- You can delete several variables at the same time (Request 208832).
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- The focus remains on the current variable when you edit it (Request 208418).

- In Queries View, you can directly edit a query and open it in the Query Panel by
clicking the Edit Query icon (/).

Build Side Panel

The Edit mode introduces a second side panel that can be opened or closed through a
fourth button (%) located in the toolbar. This second side panel replaces the modal
dialog boxes (Assign, Turn To, Format, Breaks, Sort, ...) available in previous
releases. It contains all the properties that were previously exposed in the modal dialog
boxes. Depending on their category, these properties are displayed in one of these two
panels:

- Data, defines the data structure of the item you have selected
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- Format, defines the format of the item you have selected

You can switch from one panel to another by clicking their respective header.

They are contextual panels and the displayed properties depend on your selection.
When you select an element, it automatically displays the relevant properties.

The properties you set in the Data panel are immediately applied to the selected item.
You can decide to automatically apply the properties you picked in the Format panel by
selecting the Instant Apply checkbox at the bottom of the panel. As these format
changes imply regular requests to the server for each modification, you may prefer to
unselect this checkbox and rather click Apply in one request to the server.

V| Instant Apply

Edit Mode: Format Panel Apply Options

This new side panel is one of the main enhancements of the document authoring
workflows. As described in the next two sections, setting a format or organizing a block
feed is much easier through this side panel than via the previous dialog boxes
(Requests 109434 and 107959).

Build Side Panel: Data

The Data panel is available when you select a chart or a table and is used to define the
data and structure of this selected table or chart block. The corresponding properties of
the Data panel are organized in tabs, and only tabs relevant to your selection are
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displayed. These tabs are:

. %: The Feeding tab contains the Turn into command used to select the table or
chart type for this block. If you have registered custom elements in the CMC,
they appear in the last menu of the Turn Into command.

Outerwear

Accessonies © Ciry Skiers Cary Trousers
D) Overcoats

Jackens cather
O Sweat-T-Shits O Trousers

criv TR A Start
Map Satellite %3 P ;;] y Mo
S8 End
""" Mami
Mode
B Driving
Sanrics 3
TG 3 W
[y - % AN
AL ” s SR I
—— % @ ¢ &
[ 1% f
# 1.5R 600000 and <+400008 % ?
ks - gt 5
LEETep—p— \ L Mexico | = @ +
® 457 1460000 and <=3000050 i " e
- Mesx Ty
Go'gle Wl -

" manager
+ Quarter
+ Ste
> 4 Store name

"2 Sales revenue & vear

v Messures

= Margin

Edit Mode: Selecting Custom Element (Courtesy from Need4Viz)

The Data Assignment section defines the objects used in the selected table or
the chart. You may easily add objects to this block by drag-and-dropping them
from the My Objects panel. Drag and drop can also be used to more easily

change the objects’ order in the block.
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Block1 7/

>  Tum Into... v Dimensions

Vv Data Assignment e # Category
. #* Lines
v Columns (0)

#= SKU number
Drop ar
£ Year
< Month Name
v Measures

Margin

Quantity sold

Edit Mode: Adding Objects to a Table Through Drag and Drop

Another way to add objects is to click the More icon (ee¢), select
the Formula and picks them from the Formula Editor or enter a formula to feed
the block.
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Y: To manage the Filters and Element Links for the selected block. If a filter
has been defined, then a dot is displayed on the tab. This tab provides an
overview of all filters that apply to this block by listing also the input controls.

T¢: To manage the Sort that applies to the selected block. If sorts have been
defined, the number of defined sorts is displayed on the tab.

Y10 manage the Ranking that applies to the selected block. If a ranking is
defined, a dot is displayed on the tab.

7A: To manage the Breaks options of the selected table.
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Format Series &
3 v, N, ©

® - (= - [=]
G B e

LA R

v Data Assignment

~v  Category Axis (2) voo

o Year

| <= Quarter

| Drop an object from the object
| list.

v Value Axis 1 (2)

T Margin

| T Tarmat

Format Series /'
X v, W, @

Filtered By Element Link

~  Filters

City

Chicago, New York, Miam...

Drop an object from the object list.

v Active Input Controls

Year 3
2017, 2018, 2019, 2016

Edit Mode: Data Sub-Tabs for a Chart

Build Side Panel: Format

Format Series /'

A v, M, @
~  Sorts (1) o
% Year
Ascending sort =
Add a sort v

Format Series #
A v, T, @

Rank

CJ Add a rank

The Format panel contains all formatting properties for the selected item: report, cell,
table, table cell, chart... To select a specific area of a chart (axis, title, legend, ...), you

can either:

- Click this area in the chart itself.
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- Or select the chart and then the desired chart area in the menu located beside
the chart’'s name in the Format

Block2 v Z D v
® Legend > | &

Plotarea > Plot area

v
Title Data Label

Title >

Edit Mode: Chart Area Selection

The properties you can set depend on your selection, since some may not be relevant
to your selection. These properties are organized by categories in the Format panel’s
sub-tabs.

. @®: Contains Display settings. For tables, it includes the properties that define
what must be displayed or hidden: header, footer, object name, hide when
empty, duplicate rows aggregation... For charts, it also includes the components
to be displayed or not: title, data label, legend, ...

41



D: Contains Appearance settings, like background color, borders' definition,
spacing, padding...

T: Contains Text settings, like its police, font, color, alignment, ...

(2 Contains Styling settings for charts, like palette, markers size...

>&: Contains Layout settings. For pages, it includes print layout, margins and
scaling properties. For blocks, it includes relative positioning regarding other
blocks, size and page break options...
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Format Series ~ /£ & v Format Series ~ /&) - Format Series ~ /# &3 ~ Format Series ~ # &9
& [ ) A @ I %) A & O @ A ® O ] A¥
v  Display v Background v Measure Style v Size
71 Title > Color ™ Value Axis 1 Width
RGBA Gradient Margin — 2294 4 cm
v| Data Label .
’ Color Region Type Height
~v  Legend - Bars ~ — 800 4+ com

Graphical Attributes for...

Legend
Autom... v > ~  Border m Overrid... v Relative Position
Target i i
Title 5 ® - | Pan o : Left edge of this chart is
Region Type — 050 4+ cmio
) HH Default Value ~
Vv Category Axis = Left edge of the report  ~
v| Category > v Palettes Top edge of this chart is
Axis — 050 1
B Color Palette + emto
Title > o0 000 W Top edge of the report  ~
v Value Axis 1 I
— v Markers > Layout

Valua Awvic S

7] Instant Apply 7] Instant Apply /] Instant Apply ¥| Instant Apply

Edit Mode: Format Sub-Tabs for Charts

At the top of the panel, beside the name of the selected block area (that can be

changed as in the Data side panel), you may open the Format Painter menu (). It

contains the Copy Format and Reset Format commands to respectively copy or reset
the format of the current block.

Format Series v /£ ) v L

) Reset Format
N Rackoroiind -
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Edit Mode: Format Menu

Query Panels

When you create a document or add a query to an existing document, you are asked to
select a data source type and then the data source itself.

New Document - Select a Data Source

32 Universe
Select a universe as a data source

(» Web Intelligence document
Use a Web Intelligence document as a data source

fe= Excel
Select an Excel spreadsheet as a data source

8w SAP BW (incl. BW/4HANA and S/4HANA)
Select a BEx query or BW Info provider as data source

Edana SAP HANA
Select an SAP HANA view as a data source

& Free-hand SQL
Select a relational connection as a data source

N No data source
Create an empty document

OK Cancel

Query Panel: Data Source Type Selection

The Query Panel opens, and you can select objects to create a query and retrieve the



corresponding dataset. This Query Panel depends on the data source type. In SAP Bl
4.3, these Query Panels are similar to the ones available in SAP Bl 4.2, except for the
FIORI skin, and propose the same features.

Query Panel
o @eo wov
Query 1 v
eFashion -
Result Objects x i « =
% Long opening hours. > e City ! = Store name : e Address £ Transaction Amount (3]
# Name of manager <
Sales revenue ] Quantity sold
4 Opening date .
§ Owned (y/n)
~ b Sales foor size group Query Filters ’ x ® T
# Sakes foor size sgft ’ % State Inlist ~ | Enter value(s) for State @ =
Extended sales floor size < m
ik Year Equalto - 2019 = ®
> Product =
> Promations
Data Preview C Refresh
v [ Transactions Details
7 ext to fiiter the values
# Transaction number
City Store name Address Transaction Amount Sales revenue Quantity sold
# Transaction Date
. ) Miami e-Fashion Miami Su... 32, Sundance Place 26891.4 $26891 173
2 _Transaction Date Time

Query Panel: Universe Data Source



RUR" %= Apply Changes and Close

Query Panel: Excel Data Source

To run the query and close the query panel, click Run. If your document contains
several queries, you can open a menu from this button and select the query to run.

Run Sales Details

Run City Details

Run State Area

Run all queries

Run ~= Apply Changes and Close  Cancel

Query Panel: Selecting Query to Run

Query Panel LA

Add Query

Sales Details City Details -~  State Area v

Obiject Properties Result Objects
ame: chy i City i Latitude idb Longitude
Qualification: < Dimension e
Type: stiing . i7 Inhabitants
Aggregate function: Surr
Associated dimension:

Query Properties Data Preview (", Refresh
Name: City Details Type a text to filter the values Q
Source Path:  /Web Intelligence Samples/Resources//iZZ_USCi = ... City Latitude Longitude Inhabitants

7] Refreshable Austin 30.2676 -07.74208 931830

Query Definition Boston 42,35863 -71.0567 6567137

Edit settings.. Chicago 41.88415 -87.63241 2695598
Colorado Springs 38.83345 -104.82181 416427
Dallas 32.77815 -06.7954 1300092

Cancel
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Refresh and Purge Queries

The Refresh menu (C‘) of the toolbar's Data section contains the following commands:

- Refresh to refresh all authorized queries.

- Refresh Data For to open a dialog box that provides some statistics about the
queries’ last refresh. You can explicitly select the data sources to refresh during
the next document refresh.
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Refresh Data Providers

v| - Data Providers Last refresh date Last refresh durati...  Number of rows Status
v| * Sales Details 9/25/2019 5:02:22... 1s 696

v| * City Details 9/25/2019 5:02:22... 1s 1

+| * State Area 9/25/2019 5:02:22... 1s 8

Refresh’ Cancel

Refresh Data Providers Dialog Box

The toolbar’s Data section also contains the Purge Data command that opens

the Purge Data Providers dialog box. The content of this dialog box is the same as in
the Refresh Data Providers dialog box. However here, you can explicitly purge data
from the data providers of your choice by selecting the checkbox in front of the data
providers and clicking Purge (Request 143679).

Purge Data Providers

Data Providers Last Refresh Date Duration Rows Status
3% Sales Details 9/25/2019 5.02:22 PM 1s 696
@a City Details 9/25/2019 5:02:22 PM 1s 11

v (e State Area 9/25/2019 5:02:22 PM 1s 8

Purge Cancel
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Purge Data Providers Dialog Box

Web Intelligence: Rich Client T

SAP Bl 4.3 also offers Web Intelligence Rich Client for desktop usage. It is not a Java
application any longer bur rather reuses the same interface as the SAP Bl 4.3 web
version in Bl Launch Pad.

As all desktop tools in SAP Bl 4.3 (Information Design Tool, Universe Design Tool...), it
is released in 64-bit (Request 107828).

Login

You can start Web Intelligence Rich Client from the Start menu or by double-clicking a
locally-saved Web Intelligence document. You land on the login page the process of
which has been simplified (Request 127659). You are required to enter the system
name, your credentials and the authentication mode. With the toggle button, you can
choose to work in Online or Offline mode (used to work disconnected after you have
retrieved resources locally on your desktop).

The Standalone and ZABO modes (allowing you to download and install Web
Intelligence Rich Client from Bl Launch Pad) are not yet released.
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" Start Session

Start a new session using credentials and authentication modes
or use the offline mode.

System
 BOESERVER

Authentication Mode

Enterprise v
User

cas
Password

Your Password...
Work offline (O nO )

Web Intelligence Rich Client : Login Page

If your login parameters are valid, Web Intelligence Rich Client displays
the Welcome page.

Welcome Page

The new Web Intelligence Welcome page design is similar to the Home Page of B
Launch Pad.
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¥ Web Intelligence Rich Client - [cas - @BOESERVER Online] - [m} X

Import Open New

Download & document Browse documents on Create a document
from your Enterprise your local disk

system

[l L +

Web Intelligence Rich Client: Home Page

Three tiles are displayed at the top of this page. They offer actions that follow the
workflows of your documents:

- Import: To select a document in the Bl Platform repository and explicitly import it
toa local folder so that you can edit it.

- Open: To open a document you have previously imported on your local file
system.

- New: To create a local document.
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The Welcome page also displays two other sections:

The Recent Local Documents section displays tiles for the local documents you
have previously opened. These tiles contain a thumbnail of the document, a
snapshot taken the last time the document was saved, as well as its last save
date. Click a tile to open the corresponding document.

The Open Documents section displays tiles for the documents that are open in
this session. These tiles show a thumbnail of the active report of the document.
You can also click this thumbnail to quickly switch to this document or click the
cross icon in the tile’s header to close it.
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W Web Intelligence Rich Client - [cas - @BOESERVER Online]

ZZ_Time Dirnersions.

X

£ June 26, 2020
5:27PM

Web Intelligence Rich Client: Recent and Open Documents Tiles in Welcome Page

The drop-down menu at the top of the Welcome page header, contains the following
commands:

- Settings: to set Web Intelligence Rich Client parameters like the local

documents’ default folder, the drill options, the locales or the measurement unit.

- Help and About: To open the usual Online Help and About dialog box.

- Log Out: to logout and return to the Login page.
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- Exit: to exit the tool. When exiting, all local Web Intelligence processes are
terminated.

¥ Web Intelligence Rich Client - [cas - @BOESERVER Online]

SAP

Open

Browse documents on
fromye =3 Exit your local disk
syste

y Log Out

Web Intelligence Rich Client: User Menu
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Settings

Sder;eral ‘ General @%
L oooiment ple erences Edit document preferences
Locale

Edit application preferences Select default folders:

User documents:  C:\Users\AdministratoriDocumentsiMy SAP Business...  Browse...

Universes: C:Users\AdministratortAppDataiRoamingiSAP Busin... Browse...
Select a Priority for Saving to MS Excel
Prioritize the formatting of documents
®) Prioritize easy data processing in Excel
Drill Options

Synchronize drill on report blocks

Web Intelligence Rich Client: Settings Dialog Box

Creating a Document

To create a local document, click the New tile in the Welcome page. The interface and
workflows to create a document are the same as in Bl launch Pad:
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- Select the data source type, then the data source itself. (The data source you
can select must be stored in the repository; local data providers are not yet
supported.)

. Create and run your query.

- Add charts, tables, formatting... to your report and add new reports and queries

Basically, you can take advantage of the same Edit and Read modes as in the web
version, except for some features that are not yet supported or not yet available:

- You can view comments but cannot modify comments on local documents.

- You cannot send a document to Bl Platform users.

Once you have finalized your document, you can:
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- Save it locally by selecting the File > Save You can reopen it later by selecting
the Open tile in the Welcome page.

- Publish it in the Bl Platform repository by selecting the File > Publish to
Enterprise command, and then select the destination folder in the Publish
Document dialog box.

Publish Document
Options Categories

Folders [+ W C  Documents AW C
> [#7] My Folders (=] ZZ_Activity Follow-up Dashboard
~ [ Public Folders (2] ZZ_Charting

> Auditing (2] ZZ_Fold Unfold

> [ Data Federation (2] ZZ_Input Controls

> [ ] Docs Waa$ (c] ZZ_Multiple Data Sources

> Feature HANA InA (£] ZZ_Rio Games 2016

> [ Feature HANA Smart Refresh (2] ZZ_Sales Analysis Dashboard

> [ LCMm (2] ZZ_Time Dimensions

> Platform Search Scheduling

LN Drahac

File Name: 7z Rio Games 2016

Publishs Cancel

Web Intelligence Rich Client: Publish Document Dialog Box



Importing a Document from the Repository

If you have already some documents in the Bl Platform repository, you can work on
them in Web Intelligence Rich Client. Start Web Intelligence and connect to the Bl
Platform repository. In the Welcome page, click the Import tile to open the Import and
Open dialog box and select the document to import and open.

Import and Open

General
Folders C,  Documents QG
> [#7] My Folders (£ ZZ_Activity Follow-up Dashboard
~ [7] Public Folders (2] ZZ_Charting

> ] Auditing (] ZZ_Fold Unfold

> [ | Data Federation (Z] ZZ_Input Controls

> [] Docs WaaS (=] ZZ_Muliiple Data Sources

> [] Feature HANA InA (Z] ZZ_Rio Games 2016

> [ | Feature HANA Smart Refresh (Z] ZZ_Sales Analysis Dashboard

> [] LCM (2] ZZ_Time Dimensions

> [] Platform Search Scheduling

> [] Probes

> 7] Report Samples

Import and Open. Cancel

Web Intelligence Rich Client: Import and Open Dialog Box

The selected document is copied to your file system, and this copy is opened for you to
work on it using the same interface as in Bl Launch Pad.
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Once you have finalized your changes, you can save it in the Bl Platform repository
again by selecting the File > Publish to Enterprise command first, and the destination
folder in the Publish Document dialog box as a second step.

You may prefer to save it locally for further changes before publishing it. In this case,
select the File > Save command or select the File > Make Copy one to create another

local copy.

In both cases, depending on your security rights, you may save it:

- With document access to all users, so that all repository users that have provided
their credentials can open it.

- While removing the document's security, so that users do not need to
authenticate anymore.

- While keeping it secured for you only.

Later on, if you restart Web Intelligence Rich Client in Online or Offline mode, you can
reopen this local copy by clicking the Open tile in the Welcome page.

Web Intelligence: Document as a Data Source T
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The support of Web Intelligence document as a data source for another document is a
new capability offered in SAP Bl 4.3 (Requests 107970 and 109142). The source
document can be considered as a virtual universe and a database; and their metadata
and data can be shared and leveraged by other documents.

This feature covers several use-cases:

- A document that queries a large dataset can be refreshed during quiet periods
through a schedule and then be used as a data source for other documents.
These documents do not query the initial data sources, but the dataset saved in
the source document. This prevents initial data sources from being too solicited
and improves the refresh time.

- A power report designer may prepare metadata (merged dimensions, geo-
dimensions, time dimensions, variables) and share it through a source document.

- Likewise, a document that queries multiple heterogeneous data sources can be
exposed as one single metadata provider and hide the complexity of the data
sources it queries.

Creating a Query
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When you create a document or add a query to an existing document, you can
select Web Intelligence document in the list of possible data sources.

Add Query .,

3% Universe

Ew  SAP BW

Eians SAP HANA

fe  Excel

£ Free Hand SQL

Web Intelligence: Adding a New Query

You are then asked to select a document in your Personal folders or in
the Public folders of the Bl Platform repository.
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Open a Web Intelligence Document

General
Folders C,  Documents Q G
> [#] My Folders (z] ZZ_Activity Follow-up Dashboard
v~ [] Public Folders {z] ZZ_Charting

> [] Auditing (2] ZZ_Fold Unfold

> [] Data Federation (2] ZZ_Input Controls

> [] LCM 0 ZZ_Multiple Data Sources

> [] Platform Search Scheduling El ZZ Rio Games 2016

> [] Probes ] ZZ_Sales Analysis Dashboard

> [] Report Samples (z] ZZ_Time Dimensions

> [ Scheduling_doc

> [ System Configuration Wizard

> [] Visual Difference

Web Intelligence: Document Selection

Once you have selected the source document, the Query Panel opens and displays the
document’s objects: its dimensions, attributes, measures, hierarchies or variables... You
can define a query by drag-and-dropping objects in the Results Objects section. You
can also add filters in the Query Filters section to narrow down the dataset to retrieve
from the source document.

This Query Panel is very similar to the one used for universes, although it does not yet
support features like combined queries, advanced filters or query stripping.
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[l
Ly

Query Panel

Add Query ., m 2 o @

Query 2 ~ hd
Type here to filter the tree Q 3 E
i @ g Result Objects YoOX W e =
~ [T ZZ_Multiple Data Sources
> S S -4
v [ Al Objects il State() il Store name iTn Area
<
> b City imr Sales revenue
4 Latitude
< Longitude Query Filters X W 2
~ i b Month 5 " = -
1efe Year InList 2019;2018;2017 = ®
# Month Name 7
> Sate Data Preview Result 1 ~ | C Refresh
<% StateArea
' Type a text to filter the values Result0 Q
<% Store name : .
. State () Latitude (1) Longitude (1) Store name
& Year
California 37.2537508434263 -119.615528312587 e-Fashion Los Ange... 18412952
=7 Area
E . California 37.2537508434263 -119.615528312587  e-Fashion San Fran... 1399557.2
= Inhabitants
Colorado 38.9085390230892 -105.54782586654 e-Fashion Colorado... 8843015

= Margin

Run" Apply Changes and Close  Cancel

Query Panel: Web Intelligence Document Data Source

If the source document contains hierarchies, you may use the Member Selector to
select the members to query. This Member Selector supports the same operators as
for SAP BW data sources: Children, Descendants Until and Descendants Unit Named
Level, but not Ancestors nor Parents.

Refreshing Data

The refresh retrieves the dataset from the source document. If your query contains
filters or member selections, they are applied when it is sent to the source document.

After the refresh, the objects that your query consists of appear in the My

Objects panel. You can use them to feed the tables and charts in your report like you
would for any data source. If you have enriched the source document with merged
dimensions and/or geographical or time dimensions, they are retrieved as well and can
be reused in the new document.



During this refresh, the source document is not refreshed. This is the reason why a
source a document defined as being refreshed on open or based on an SAP HANA
Online data source, cannot be used as a data source. The source document must be
explicitly refreshed, either manually or through a schedule. If the Smart View option has
been selected in the CMC, the data is retrieved from the source document’s last
scheduled instance.

The aggregation of variable defined as measure is delegated to the source document. If
you change the aggregation scope, the measure returns #TOREFRESH. Refresh the
document to send the query against the source document so it returns the new
aggregated value for the measure.

View-Time Security Filtering

The date of the dataset retrieved from the source document corresponds to the source
document’s last refresh time. At refresh time, it is secured with the security profiles that
apply to the user who is running the query. As the source document is not refreshed, it
might be an issue if this source document dataset is shared with other users who do not
have the same security profiles.

If the source document queries a universe created with Information Design Tool and
secured with a Business Security Profile, you can enable the Apply security filtering
at view time option (see SAP Bl 4.2 SP6) to filter the dataset when a document based
on this source document is opened.

If you set this option for the consuming document, the Business Security Profiles that
apply to the user are enforced on the fly when the document is opened and without
refreshing the source document, nor the document created on it:

- Display Data Business Security Profiles prevents a denied object and its data to
be displayed.
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- Only rows that match the filters conditions defined in the Filters Business
Security Profiles are displayed.

If you set this option for the source document, the filtering is applied when data is
retrieved from this source document:

- Display Data Business Security Profiles prevents a denied object and its data
from being retrieved.

- Only rows that match the filters conditions defined in the Filters Business
Security Profiles are retrieved.

You can also set this option for both documents.

As this security relies on universe’s Business Security Profile, it applies only to source
document queries based on universe created in Information Design Tool.

Document Dependencies

In the BI Platform repository, a link is created between the source document and a
document that uses it as a source. Hence, dependencies between these documents are
properly displayed in Life Cycle Management, Promotion Wizard or in the CMC if you
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use Tools > Check Relationships.

Query Results v Welcome: Administrator | Preferences | Help = | Log Off
| panage = Actions Find Title ~ i)
-
LIS & & 2 & o4 ofl » M
S ) - orctionstip Queries Title Type Description Path Date Modified
= eFashion.unx Universe (information design eFashion retail Data Warehouse datt Universes/Samples/ Jun 3, 2020 2:11 AM
¥ 7Z_Multiple Data Sources MyDashboard Web Intelligence User Folders/Administrator/ | Jun 3, 2020 2:41 AM

5 B #R sacuity Queries Platform Search Content Store Merge Queue  class com.sap.businessobject Platform Search Root/Platfort Jun 3, 2020 12:26 AM
5 Summary Web Intelligence ‘Web Intelligence Samples/  Jun 3, 2020 2:46 AM

l'IF Web Intelligence Samples Folder Jun 3, 2020 12:35 AM
_“’ ZZ_SAPLogo SharedElement Web Intelligence Samples/Re Jun 3, 2020 2:11 AM

] ZZ_lsCitiesInhabitants Microsoft Excel Web Intelligence Samples/Re Jun 3, 2020 2:11 AM

B ZZ_USStatesArea Microsoft Excel ‘Web Intelligence Samples/Re Jun 3, 2020 2:11 AM

* »
%‘ Tatzl: 8 items
|T_'

CMC: Source Document Relationship

Web Intelligence: Geo Map T

To provide more accurate geo dimensions, the Here geographical database used by
Web Intelligence has been updated with its 2019 version:

- Borders and regions take geographical changes into consideration, e.g., new
French regions are available (Request 144513).

- Regions, sub-regions and cities have been added in some countries for better
coverage.
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New cities have been added, some have been removed, considering the
100,000 inhabitants limit, except for the United States of America.

Revenue by Region

Geo-Map: New French Regions
If you have created geo charts in SAP Bl 4.2 with a mapping by name, you need to

remap these names when editing these documents in SAP Bl 4.3 due to ID changes in
the geographical database.

Web Intelligence: Formula Language Functions and
Formula Editor T

In the Data Provider category, DataProviderType has been updated to return the correct
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data provider type. The possible values are: "Universe", "Text", "Excel", "Web Services",
"SAP BW", "SAP HANA", "Free-Hand SQL" and "Web Intelligence" for the new Web
Intelligence document data source. Besides NumberOfRows, NumberOfColumns has
been added to return the number of objects of a data provider.

- string DataProviderType ( Data provider dp )

« int NumberOfColumns ( Data provider dp )

In

the Document category, DocumentPath, DocumentParentFolder and DocumentParentF
older have been added to respectively return the document’s path (Request 108755),
the name of its parent folder (Request 206442) and the document description

(Request 144988). QuerySummary has also been updated to return the correct data
provider type (cf. DataProviderType).

- string DocumentPath ()

- string DocumentParentFolder ()
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- string DocumentDescription ()

- string QuerySummary ()

In the String category, Trim, LeftTrim and RightTrim have been extended to allow you to
define the character to remove from the string (Request 217310). By default, this
character is the space character.

- string Trim ( string str [; string ch] )

- string LeftTrim ( string str [; string ch] )

- string RightTrim ( string str [; string ch] )

To create more readable and maintainable formulas, you can use the classic comments
usually supported by most programming languages (Request 111272) in the formula
language:
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«  To comment the end of a line, you may use //

« To comment a block in the formula, you may use /* */

When you open the Formula Editor, all category folders are closed by default
(Request 202146). To find a function more easily, the All category (that contains all
functions) is displayed at the top of the categories' list.

As in the Formula Bar, the Formula Editor supports auto-completion. When you type a
formula, a menu displays the objects, functions or operators that match the letters you
typed (Request 241647). Select the one to use by clicking it or using the arrows keys
and pressing [Enter].
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Edit Variable 22
Name:
Pareto line
Description:
Qualification: Type:
T Measure v Number
Formula
/* Used in Pareto Chart */ i
=Round (RunningSum([Sales revenue])/Sum([Sales revenue]ForAll([Lines]))*100; 0) / ma X
Il Last changed: 2020 June 2
Max
_ Functions Operators
LI Match
=" ) = < <= || <> p- >=
T Margin > DAL
< + i *
i Max Value > Q) Aggregate P
> ) Character Values...
mr 75 to 100%
> [ DataProvider Prompts...
™7 Actual value
Quantity sold
OK" Cancel

Auto-Completion in the Formula Editor
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Web Intelligence: Security Rights T

To adapt the new interface and deployment modes, the Web Intelligence security rights
have been updated:

- Names and categories have been simplified and aligned (Request 214981)

- Two new rights are introduced to secure the use of Free-Hand SQL

(Request 219070 Query: Edit Free Hand SQL script and Query: View
Free Hand SQL script

The following table lists Web Intelligence application
security rights, with their equivalent in SAP Bl 4.2.
Previous SAP BI 4.2 Name

SAP BI 4.3 Security Right

Data: Enable data tracking Data - Enable data tracking

Data: Enable formatting of changed data Data - Enable formatting of changed data

General: Enable Desktop client access Desktop interface - Enable Web Intelligence
Deskto

Desktop: Publish to Enterprise
Desktop interface - Export documents

Desktop: Print documents
Desktop interface - Print documents
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Desktop: Remove documents security
Desktop: Give access to everyone

Documents: Disable automatic refresh on open
Documents: Enable autosave

Documents: Enable creation

Documents: Publish and manage content as web service

General: Edit Web Intelligence preferences

General: Enable Web client access

Query: Edit script generated from universe
Query: Edit Free Hand SQL

Query: View script generated from universe
Query: View Free Hand SQL

Reporting: Create and edit breaks

Reporting: Create and edit conditional formatting rules
Reporting: Create and edit input controls and group

Reporting: Create and edit predefined calculations

Reporting: Create and edit filters and consume input
controls

Reporting: Create and edit sorts and rankings

Reporting: Create and edit formulas, variables, groups and

references

Reporting: Enable document change

Reporting: Merge objects

Reporting: Insert and remove reports, tables, charts, and
cells

Desktop interface - Remove document security
Desktop interface - Save document for all users
Documents - Disable automatic refresh on open
Documents - Enable autosave
Documents - Enable creation

Documents - enable publish and manage content as
service

General - Edit ‘My Preferences’
Interfaces - Enable web viewing interface
Query script - Enable editing (SQL , MDX, ...)

Query script - Enable viewing (SQL , MDX, ...)

Reporting - Create and edit breaks
Reporting - Create and edit conditional formatting
r

Reporting - Create and edit input controls

Reporting - Create and edit predefined calculations
Reporting - Create and edit report filters and consu
input controls

Reporting - Create and edit sorts

Reporting - Create formulas and variables

Reporting - Enable formatting
Reporting - Enable merged dimensions

Reporting - Insert and remove reports, tables, chart
cells

In the CMC, the following rights are prefixed with the “Obsolete_” tag since they are

either useless in SAP Bl 4.3 or their security intent is replaced by customization when it
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is supported:

- Disable Export to Bl On Demand for this user

- Disable Import from Bl On Demand for this user

- General - Enable right-click menus

- Interfaces - Enable Rich Internet Application

- Left pane - Enable document structure and filters

- Left pane - Enable document summary

- Desktop interface - Save documents locally
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- Desktop interface - Import documents

CMC: Web Intelligence Application Security Rights

The following rights are still exposed in the CMC but will be leveraged once the

corresponding features are supported:

- Desktop: Send by e-mail

- Desktop: Enable local data providers

Add/Remove Rights A=k
Object:  Web Intelligence wSpecific Rights for Web Intelligence Implicit Value L] Q ? R
Principal: Administrators Desktop: Publish to Enterprise Granted @] @) ® =
vGeneErI:'l_'eral Desktop: Remove documents security Granted C ®
wApplication Desktop: Send by e-mail Granted C ®

Documents: Disable automatic refresh on open Granted C ®
Documents: Enable auto save Granted ( ®
Documents: Enable creation Granted O ®
Documents: Publish and manage content as web service Granted O [C]
General: Edit Web Intelligence preferences Granted O O ®
General: Enable Desktop client access Granted O O ®
General: Enable Web client access Granted O O ® -
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- Desktop: Install from Bl Launch Pad

- Shared: Publish shared elements

- Shared: Insert shared elements

The following table lists Web Intelligence document
security rights, with their equivalent in SAP Bl 4.2.

SAP BI 4.3 Security Right
Edit Query

Export the cube’s data
Export the report’s data
Import document locally
Refresh List of Values
Refresh the report’s data
Use Lists of Values

View SQL

Previous SAP BI 4.2 Name

Edit Query

Save as CSV

Export the report’s data
N/A

Refresh List of Values
Refresh the report’s data
Use Lists of Values
View SQL

The Save as Excel or Text and Save as PDF security rights have been removed since
exporting or scheduling report’s data into PDF, Excel, HTML archive, Text or CSV
archive is now simply covered by the Export the report’s data right.

Two new rights have been introduced:
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- Export the cube’s data: This right allows the user to export a document’s cube
data or to schedule it into a CSV file. (Request 134236)

- Import document locally:This new right replaces the previous application Desktop
interface - Save documents locally and Desktop interface - Import documents
security rights and is used to allow the document to be saved locally so that it
can be opened in Web Intelligence Rich Client.

The Publish shared elements right is still exposed in the CMC but will be leveraged only
when the corresponding feature is supported.

Web Intelligence: Publishing and Scheduling T

When the new Bl Launch Pad was released in SAP Bl 4.2 SP4, it was possible to
schedule documents but not to distribute them through publications. In SAP Bl 4.3, this
missing capability has been implemented in Bl Launch Pad and offers the same options
as in SAP Bl 4.2.

To create a publication, go to a folder, click the Create/upload objects button (+) at
the top of the folder’s page and select Publication in the menu.
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@ e 2

T o o

New Folder
Publication
Upload Document

Hyperlink
Update..

Bl Launch Pad: Publication in the Create Menu

In the New Publication page, enter the publication parameters. These parameters are
organized by sections, displayed in two tabs. Depending on the document type, some
parameters appear only after the source documents have been added to the
publication.

New Publication

General Summary

Publication Details

*Title

Keywords

Description

Source Documents

Items (0) +

Title Type Refresh at Runtime

Save Saveand Close Close
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Bl Launch Pad: New Publication

To navigate into the possible parameters more easily, you may click the following tabs,
and select the section in the corresponding menus:

- General. This tab contains the generic publication parameters: publication
details, source documents, destination, recurrence, enterprise and dynamics
recipients, events, ...

- Report Features. This tab and its sections appear if your publication contains a
Web Intelligence or Crystal Reports document. It contains publication properties
that are specific to this document type. For Web Intelligence, this covers the
publication formats, personalization, prompts and delivery rules.

- Summary: This tab displays the publication’s most common parameters.
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General Report Features v Summary General ~~ Report Features Summary General “~ Report Features v Summary v

Publication Details Formats Publication Details
Publication e Publication Details
Source Documents Personalization Source Documents
Destinations *Title Prompis *Title Destinations
Recurrence Delivery Rules Recurrence
X Keywords Keywords
Enterprise Recipients Recipients

Dynamic Recipients
Events

Scheduling Server Group

Source Documents Source Documents
Advanced

Matification Items (1) ltems (1)

Bl Launch Pad: Publication Menus
When the publication is defined, click Save or Save and Close.
In SAP Bl 4.3, you can still schedule a document. To provide the same look & feel as

in New Publication page, the Schedule page has been modified.

Schedule

General v Report Features

Instance Title

*Title

ZZ_Charting

Destinations

Delivery Destinations

Add

Selected Delivery Destinations
Default Enterprise Location ®

Recurrence

Schedule Close
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Bl Launch Pad: New Schedule

When defining a schedule, you can move to specific sections through two tabs and the
corresponding menus.

- The General tab contains the generic sections that define a schedule, like the
schedule's destinations and recurrence, its attached events, ...

- The Report Features tab contains the sections specific to a Web Intelligence
document. Formats, Prompts and Delivery Rules are available, but Caching
properties are not yet implemented.

General v Report Features v General v Report Features v
Instance Title Formats

o Instance Tit
Destinations Prompts
Recurrence *Title - Delivery Rules |
Events ZZ_Charting

Scheduling Server Group

Notification
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Bl Launch Pad: Schedule Menus

Both schedule and publication take advantage of the new options introduced in SAP Bl
4.3:

- When you define the publication or schedule frequency in
the Recurrence section, you can select business days and hours for the
schedule to run.

- Another new option, Allow Retries, can be used to define if a failed schedule
must be re-run and if so, how many times and when.
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Recurrence

Run Report:

Recurring ~
Repeat:

Business Hours v

Business Hours Start Business Hours End

06:00 70 18:00 D
Every:

01:00 79 |Ex: Every 2 hrs
Start Date:

Jun 11, 2020, 6:27:50 PM e
End Date:

Jun 11, 2030, 6:27:50 PM e}

Allow Retries

Number of Tries

1

Retry interval in sec...

1800

Bl Launch Pad: Recurrence Options

- In the Bl Launch Pad Home page, click the Instances tile to display an overview
of all schedules and publications run by you and their status. At the top of the
page, you can find controls to filter this list by date, status, scheduled object type
or just by name.
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Schedule Instances

Instance Time: Status Type: Title:
11.06.2020 - 12.06.2020 [l Success ® Failed @ | v
Success
v| Partial Success
v| Failed -
Instances (2) Running (@
Title Type Recurring Instance Time = Scheduled By Subscription
2Z_Charting  Web [ Paused Jun 12,2020 4:46 ... Administrator
ZZ_Charting » Web Expired Jun 12, 2020 4:46 ...  Administrator

Bl Launch Pad: Schedule Instances Page

Web Intelligence: OpenDocument URL T

The Copy Link of the Report/Table/Chart/Cell commands previously described allow
you to directly generate an Opendoc URL to access the corresponding item. You can
also get the link to access a document by opening the document’s contextual menu in
Bl Launch Pad and selecting the Details command. The Opendoc URL you can share
is provided in the Document Link field.
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Details
File Name : ZZ_Fold Unfold
Description : None
Keywords : None

Categories : None
Additional Details

Type : Web Intelligence
Owner : Administrator
Created On : Jun 12, 2020 2:01 AM
Last Modified : Jun 12, 2020 3:36 AM
Last Run: Jun 12, 2020 3:53 PM
ID: 5512
CUID : AXpyoryP_Z5BoXVoM2_3kWQ
Locale : en_US

Folder Path : Public Folders/Web Intelligence Samples/

Document Link :  http:/6052faff7d83:8080/BOE/OpenDocument/
opendoc/openDocument.jsp?
sIDType=CUID&iDoclD=AXpyoryP_Z5BoXVoM
2_3kwQ

Bl Launch Pad: Document Details Dialog Box

With the Web Intelligence user interface simplification, the sViewer option is no longer
used by the Opendoc URL and is skipped when it is processed. Some options like
instance are not yet supported in SAP Bl 4.3 and will be supported in future Support
Packages.

To allow your user to directly access a folder, you can select the Details command in a
folder's contextual menu, and share the URL provided in the Folder Link.
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Description :

Keywords :

Type :

Owner :

ID:

CUID:
Created On :
Last Modified :
Folder Link :

Details

Folder Name : Web Intelligence Samples

None

None

Additional Details

Folder
Administrator
5526

AeN4IEuOh_tAtnPEjFYxwig

Jun 12, 2020 2:01 AM
Jun 12, 2020 2:01 AM

http://6052faff7d83:8080/BOE/BI?

startFolder=AeN4IEu0|
false

h_tAtnPEjFYxwiB&isCat=

Bl Launch Pad: Folder Details Dialog Box

Web Intelligence: REST Web Services T

In the Web Intelligence REST Web Services, some new APls have been added:

- To get, create, edit and delete referenced cells in a document

- To get, create, edit and delete table’s calculations
(Average, Count, Max, Min, Percent or Sum)
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- To get the details of a publication

Some existing APIs offer additional options and can be used to:

Purge a document

Set a table cell as a section

Change the position of a report element in the layout (front, back...)

Delete all breaks of a table

Update or delete all breaks on a table axis

Get, edit or delete all custom formatting of a report element
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Get the details of a hierarchy member

Re-order input controls

Create a custom format for number or datetime

Get the marker palettes, the gradient orientations and the locales supported by
the Bl Platform server

Web Intelligence: Performance Enhancements T

To improve the performance of Web Intelligence, several enhancements have been
implemented:

The most visible one is the progressive disclosure, aka lazy loading: to avoid
blocking the user while the document is fully displayed, the document skeleton is
computed and displayed first, followed by the charts in the background. The gain
is particularly significant on a document that contains many charts.
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- The Web Intelligence REST Web Services calls used by the new Web
Intelligence interface have been optimized

- Documents with the Refresh on open option are automatically purged when
saved in order to reduce the document opening time (Request 110058).

- A Web Intelligence document stores details related to the universes it queries. If
one of these universes has been modified, the updated details are retrieved from
this universe when the document is opened. A warning message is displayed to
recommend that you save the document, to avoid the same update next time it is
opened.

Information Design Tool: 64-Bit T

Like other client tools in SAP Bl 4.3 (Web Intelligence Rich Client and Universe Design
Tool), Information Design Tool and Connection Server drivers are released in 64-bit
only (Request 210604).
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